
Exploring Microsoft Word 7.0

Carlotta Eaton

Exploring Access 2003 Revised - Grauer and Barber 1Committed to Shaping the Next Generation of IT Experts.

Chapter 1- Introduction to 
Access: What is a Database?

Robert Grauer and Maryann Barber

Exploring Microsoft 
Access 2003

Revised Edition

Exploring Access 2003 Revised - Grauer and Barber 2

Objectives

Define field, record, table, and database

Describe the objects in Access database

Add, edit, and delete records in a table

Use existing forms and reports
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Objectives (continued)

Explain importance of data validation

Apply filter by form or selection

Sort a table on one or more fields

Identify one-to-many relationships
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Case Study: The South Vancouver 
Preschool
The case requires students to:

Use a form to enter data about themselves

Print the completed form

Print all reports from the database
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Database Window
Menu bar

Toolbar

Database window

Object Buttons
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Introduction to a Database

Field – a basic data element
(name, phone number, title)

Record – a set of fields
(All fields for one person)

Table – a set of records

Database – one or more tables
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Fields and Records
Field – A basic fact
listed above each column

Record is an entire 
row of information

Field = columns
Record = rows
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Table Views

Datasheet view is used to add, edit, or 
delete records

Design view is used to create and modify 
fields

PivotTable view summarizes groups of data

PivotChart view charts the data from 
PivotTable view
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Datasheet View

Triangle indicates
data has been
saved to disk

Current record

Total number
of records
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Design View
DescriptionData Type

Field Properties

Field Names

Primary Key
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Tables

Record selector symbol next to current record 
shows status

Triangle indicates saved to disk

Pencil indicates you are typing

Asterisk appears next to last blank record in 
table
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Open a Table

Table Name

Select table object 
to display tables

Double click to open 
Customers table

Go to Next Record Create New RecordGo to First Record
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Tables

Insertion point — where text is entered

Primary key — unique identifier for each 
record

Access automatically saves changes when 
you move to next record
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Forms, Queries, and Reports

A form is a friendly interface for entering or 
modifying a table

A query provides a subset of a table based 
on a criteria

A report presents data in an attractive format
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Form
Table Name

Field Names

Go to Next Record

Values for 
Current Record

Command Buttons

Go to Last Record

Go to First Record
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Query

Display only customer 
records who don’t have 
a Cuppa Card
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Report

Individual Records

Customer Mailing 
Labels Report

Report Header
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Hands-on Exercise 1

Title of Exercise: Introduction to Access
Objective: To add, edit and delete records 
and  open forms, queries and reports

Input file: Bookstore database
Output file: Bookstore database (modified)
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Hands-on Exercise 1: Step 1 - Obtain 
the Practice Files
1. Start Internet Explorer, and go to 

http://www.prenhall.com/grauer. Click the 
book for Office 2003, which take you to the 
Office 2003 homepage

2. Click the student downloads tab (near the 
top of the window) to go to the student 
download page as shown in next slide

3. Click the link to download the file for the 
Exploring Access 2003 Revised Edition
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Hands-on Exercise 1: Step 1 - Obtain 
the Practice Files
4. You will see the file download box asking 

what you want to do. Click the Save button. 
The Save As dialog box appears

5. Click the down arrow in the Save In list box 
and select the drive and folder where you 
want to save the file. Click Save

6. Start Windows Explorer, select the drive 
and folder where you saved the file, then 
double click the file to follow the onscreen 
instruction
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Hands-on Exercise 1: Step 2 - Start 
Microsoft Access
1. Click the Start button, click the All Programs 

button, click Microsoft Office, then click 
Microsoft Office Access 2003 to start the 
program

2. Pull down the file menu, and click the Open 
command to display the Open dialog box. 
Do this even the task pane is open

3. Click the down arrow on the Views button, 
then click Details to change to Details view.
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Hands-on Exercise 1: Step 2 - Start 
Microsoft Access
4. Click and drag the vertical border between 

column to increase (or decrease) the size of 
a column

5. Click the drop-down arrow on the Look In 
list box. Click the appropriate drive (Drive C) 
depending on the location of your data. 
Double click the Exploring Access folder

6. Click the down scroll arrow (if needed) to 
click the Bookstore database. Click the 
open command button to open the database
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Hands-on Exercise 1: Step 2 - Start 
Microsoft Access
7. Click the Open button within the Security 

Warning dialog box if you see a warning 
message saying that the database may 
contain code to harm your computer. (The 
message caused by the programming 
statements that are behind the command 
button in the various forms within database).
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Hands-on Exercise 1: Step 3 – Open 
the Books Table
1. If necessary, click the Maximize button in 

the application window so that Access take 
the entire desktop

2. You should see the database window for 
the Bookstore database. Click the Tables 
button. Double click the icon next to Books 
to open the table as shown in next slide

3. Click the Maximize button so that the Books 
table fills the access window and reduce the 
clutter on the screen
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Hands-on Exercise 1: Step 3 – Open 
the Books Table
4. Practice with the navigation buttons above the 

status bar to move from one record to the next. 
Click ►or ◄to move forward to the next record 
or return to previous record

5. Click |◄ to move the first record in the table or 
►| to move the last record in the table

6. Click in any field of the first record. The status 
indicator at the bottom of the Books table 
indicates record 1 of 22. The triangle symbol in 
the record selector column indicates that the 
record has not changed since it was last saved.
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Hands-on Exercise 1: Step 4 – Add a 
New Record
1. Pull down the insert menu and click New Record 

(or click the New Record button on the Table 
Datasheet toolbar). The record selector moves to 
the last record (record 23). The insertion point is 
positioned in the first field (ISBN Number)

2. Enter data for the new book as shown in next 
slide. The record selector change to a pencil as 
soon as you enter the first character in the new 
record

3. Press Enter when you have entered the last field 
for the record. The record has been saved to the 
database, and the record selector changes to a 
triangle.
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Hands-on Exercise 1: Step 4 – Add a 
New Record
4. Add another record. Enter 0-13-143442-X 

as the ISBN. The title is Exploring Microsoft 
Office 2003 Volume II by Grauer/Barber. 
The Price is $79.00. The book was 
published by Prentice Hall in 2003. Be sure 
to press Enter when you have completed 
the data entry.

5. There are now 24 records in the table.
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Hands-on Exercise 1: Step 5 – Edit a 
Record
1. Click in the Title Field for the first record, pull 

down the Edit menu, and click Find (or click the 
Find button on the toolbar) to display the dialog 
box as shown in next slide

2. Enter COBOL in the Find What text box. Check 
that the other parameters for the Find 
command match the dialog box. Be sure that 
the Title field is selected in the Look In list box 
and Any Part of Field is selected in the Match 
text box
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Hands-on Exercise 1: Step 5 – Edit a 
Record

3. Click the Find Next command button. Access 
moves to record 14, the record containing the 
designated character string, and selects the 
matching word in the Title field for that record. 
Click Cancel to close the Find dialog box

4. Press the Tab key three times to move from the 
Title field to the Price field (or click directly in the 
price field). The current price ($52.95) is already 
selected

5. Type $58.95, then press the down arrow to move 
to the next record and save the data (auto).

Exploring Access 2003 Revised - Grauer and Barber 30

Hands-on Exercise 1: Step 6 –
Delete a Record

1. Use the Find command to search for the book A 
Guide to SQL. (You can click in the Title field, 
enter “SQL” in the Find What dialog box, then use 
the same search parameters as in the previous 
step)

2. The Find command should return the appropriate 
record, which is not visible in next slide. This is 
because we’ve deleted the record to display the 
dialog box in the figure.

3. Pull down the Edit menu, and click the Select 
Record command to highlight the entire record. 
You can also click the records selector column to 
select the record without having to use a pull-
down menu.
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Hands-on Exercise 1: Step 6 –
Delete a Record
4. Press the del key (or click the Delete Record 

button on the toolbar) to delete the record. You 
will see the dialog box in Figure indicating that 
you are about to delete a record and asking 
you to confirm the deletion. Click Yes to delete 
the record

5. Pull down the Edit menu. The Undo command 
is dim, indicating that you cannot undeleted a 
record. Press Esc to continue working.
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Hands-on Exercise 1: Step 7 – Print 
the Table
1. Pull down the File menu and click the Print 

Preview command to see the table prior to 
printing. The status bar indicates that you are 
viewing page 1 (and further, the active scroll 
button indicate that there are additional page)

2. Click the Setup button on the Print Preview 
toolbar to display the Page Setup dialog box as 
shown in next slide

3. Click the Page tab. Click the Landscape option 
button. Click OK to accept the setting and 
close the dialog box
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Hands-on Exercise 1: Step 7 – Print 
the Table
4. The table should now fit on one page. (If it still 

does not fit on one page, click the Setup button 
on the Print Preview toolbar to display the Page 
Setup dialog box, click the Margins tab, and 
make the margin smaller

5. Click the Print button to print the table. 
Alternatively, you can pull down the File menu, 
click Print to display the Print dialog box, click 
the All options button, then click OK)

6. Click Close to close the Print Preview window. 
Close the table. 
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Hands-on Exercise 1: Step 8 - Open 
the Book Form
1. Click the Forms button in the Database 

window. Double click the Books form to open 
the form, and if necessary, maximize the form 
so that it takes the entire window

2. Click the Add Record command button, or use 
the keyboard shortcut, Alt+A (Each command 
button has a different underlined letter to 
indicate the keyboard shortcut)

3. Click in the text box for ISBN Number, the use 
the Tab key to move from field to field as you 
enter data for the book as shown in next slide.
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Hands-on Exercise 1: Step 8 - Open 
the Book Form

3. You can use a query to display information, as 
was just done, and/or you can modify data in the 
underlying table. Click in the Publisher field for 
the blank record in the last row (an asterisk). 
Type McGraw Hill to begin entering the data for a 
new record as shown in next slide.

4. You can enter data for any publisher within the 
query, but you must satisfy the requirements for 
data validation.

5. Click the Close the query form, and  return to the 
Database window.
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Hands-on Exercise 1: Step 9 – Run a 
Query
1. Click the Queries button in the Database 

window. Double click the Publisher query to 
run the query. You will see a dialog box asking 
you to enter the name of a publisher

2. Type McGraw Hill and press Enter to see the 
results of the query, which should contain three 
books by this publisher. (If you don’t see any 
books, it is because you spelled the publisher 
incorrectly. Close the query to return to 
Database window, then return the query)
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Hands-on Exercise 1: Step 9 –
Run a Query
4. The table should now fit on one page. (If it still 

does not fit on one page, click the Setup button 
on the Print Preview toolbar to display the Page 
Setup dialog box, click the Margins tab, and 
make the margin smaller

5. Click the Print button to print the table. 
Alternatively, you can pull down the File menu, 
click Print to display the Print dialog box, click 
the All options button, then click OK)

6. Click Close to close the Print Preview window. 
Close the table. 
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Hands-on Exercise 1: Step 10 - Open 
a Report
1. Click the Reports button in the Database 

window to open display the available reports. 
Double click the icon for the Publisher report. 
Type McGraw Hill in the Parameter dialog box. 
Press Enter

2. Click the maximize button so that the report 
takes the entire screen as shown  in next slide

3. Click in the Zoom button to toggle to 100% so 
that you can read the report, which should 
contain four records.
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Hands-on Exercise 1: Step 10 -
Open a Report
3. Two books were in the original database. One 

book was entered through a form in step 8. The 
other book was entered through a query in step 
9. All of the books in the report are published 
by McGraw Hill, which is consistent with the 
parameter you entered at the beginning of this 
step.

4. Click the Print button on the Report toolbar, 
Click the Close button to close to the Database 
window.
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Filters and Sorting

Filter by Selection is easiest

Filter by Form 
Allows for comparative criterion (e.g. >, <)

Allows for “or” filters (e.g. either cosmetics or 
shoes)

Remove Filter button - redisplays complete 
table
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Filter By Selection

These Records Were Filtered by 
Selection (Category = Fruity)

Apply Filter button

Select field to filter
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Sorting

The Previous Filtered Records Sorted by Recipe

Sort Ascending button

The Same Records, Only Displayed in a Different Order
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Hands-on Exercise 2

Title of Exercise: Filters and Sorting
Objective: To apply a Filter by Selection 
and Filter by Form criteria, and to sort 
records in a table

Input file: Employee database
Output file: Employee database 
(modified)
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Hands-on Exercise 2: Step 1 – Open 
the Employees Table

1. Start Access as you did in the previous exercise, 
but this time you will open a different database. 
Pull down the File menu and click the Open 
command to display the Open dialog box 

2. Click the down arrow in the Look In box to select 
the drive (drive C) and folder (Exploring Access) 
that contain Employee database

3. Click the Open button in the Open dialog box to 
open database, then click Open button within the 
Security Warning dialog box (if any)
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Hands-on Exercise 2: Step 1 – Open 
the Employees Table

4. Click the Forms button in the database window, 
then double click the Employees form to open the 
form as shown in next slide. Click the Maximize 
button so that The Employees forms fills the 
Access window

5. Click the Add Record button, then enter data for 
your self, using 12345 as the EmployeeID, and 
your first and last name. You have been hired as 
Account Rep. Your salary is $40,000, you will 
work in Miami, and your performance is Good

6. Click the Print Record button to print the record 
containing your data. Click the Close Form button 
to return to Database window.
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Hands-on Exercise 1: Step 2 – Filter 
by Selection
1. Click the Tables button in the Database window. 

Double click the Employees table to open the 
table, which should contain 15 records, including 
the record you added for your self

2. Click in the Title field of any record that contain 
the title Account Rep, then click the Filter by 
Selection button

3. You should see 9 employees, all of whom are 
Account Reps, as shown in next slide. The 
status bar indicates that there are 9 records (as 
opposed to 15) and that there is a filter condition 
in effect
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Hands-on Exercise 1: Step 4 – Add a 
New Record
4. Click in the performance field of any employee with 

a Good performance (we clicked in the 
Performance field of the first record), then click the 
Filter by Selection button a second time

5. This time you see 4 employees, each of whom is 
an Account Rep with a performance evaluation of 
Good. The status bar indicates that 4 records 
satisfy this filter condition

6. Click the Print button to print the filtered table.
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Hands-on Exercise 1: Step 3 – Filter 
by Form
1. Click the Filter by Form button to display the 

form in next slide Figure,  where you can enter or 
remove criteria in any sequence. Each time you 
click in a field, a drop-down list appears that 
displays all the value for the field that occur 
within the table

2. Click in the columns for Title and Performance to 
remove the criteria that were entered in the 
previous step. Select the existing entries 
individually and press the Del key as each entry 
is selected
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Hands-on Exercise 1: Step 3 – Filter 
by Form
3. Click in the cell underneath the Salary field and 

type >30000 (as opposed to selecting a 
specific value). Click in the cell underneath the 
Location Field, click the down arrow, and select 
Chicago

4. Click the Apply Filter button to display the 
records that satisfy these criteria (You should 
see 4 records)

5. Click the Print button to print the table.
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Hands-on Exercise 1: Step 4 – Sort 
the Table
1. Click the Remove Filter button to display the 

complete table, which contains 15 employee 
records.

2. Click in the LastName field of any record then 
click the Sort Descending button. The records 
are displayed in alphabetical (ascending) order 
by last name as shown in Figure

3. Click in the Salary field of any record, then click 
the Sort Descending button. The records are in 
descending order of salary; that is, the employee 
with the highest salary is listed first
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Hands-on Exercise 1: Step 4 – Sort 
the Table
4. Click in the Location field of any record then 

click the Sort Aescending button to display the 
records by location, although the employees 
within a location are not in any specific order

5. You can sort on two fields at the same time, 
provided the fields are next to each other, as 
described in the next step.
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Hands-on Exercise 1: Step 5 – Sort 
on Two Fields
1. Click the header for the Location field to select the entire 

column. Click and drag the Location header so that the 
Location field is moved to the left of the Lastname field.

2. Click anywhere to deselect the column, then click on the 
Location header and click and drag to select both the 
Location header and the Lastname header as shown in 
Figure.

3. Click the Sort Ascending button. The records are sorted 
by location and alphabetically within location. (You could 
extend the sort to three fields such as Location, 
LastName, and FirstName by selecting all three fields 
prior to clicking the Sort button

4. Print the table. Close the table, saving the changes when 
prompted to do so
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Hands-on Exercise 1: Step 5 –
Sort on Two Fields
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Hands-on Exercise 1: Step 6 – Print 
a Report

1. Click the Report button in Database window. Double 
click the icon for Employees by Location Report

2. Click in the Maximize button in the Report Window so 
that the report takes the entire screen as shown in 
figure

3. Click in the Zoom button to toggle to 100% so that 
you can read the report. The displays the employees 
in the same order as the sorted table from step 5. 
(The sequence for the report is contained in its design 
specification and does not depend on the sequence 
of the underlying table)
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Hands-on Exercise 1: Step 4 –
Sort the Table
4. Click in the Print button on the Report toolbar 

to print the report. Submit all the printed 
information:

The employee form from step 1
The filtered table from steps 2 and 3
The sorted table from step 5
The Employees by Location report from this step

5. Close the report. Exit Access if you do not 
want to continue with the next exercise at this 
time.
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Relational Database

Uses multiple tables

Examples of one-to-many relationships: 
One publisher has many books
One customer has many purchases
One student has many courses
One instructor has many students
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Relationships Window

Table Names

Field Names

One-To-Many
Relationship
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Modifying Related Information

Modifying the address information for Location L04
changes the information for all individual employees at L04

Clicking plus
sign displays 
all employees 
at L04
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Displaying Related Information

Related information is easily grouped 
together when creating reports

Employees are grouped 
by their location
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Hands-on Exercise 3 (next week)

Title of Exercise: A Look Ahead
Objective: To identify one-to-many 
relationships within a database

Input file: Look Ahead database
Output file: Look Ahead database 
(modified)
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Hands-on Exercise 3: Step 1 – Open 
the Relationship Window

1. Start Access as you did in the previous exercise. 
Pull down the File menu and click the Open 
command to display the Open dialog box. Open 
the Look Ahead database in the Exploring 
Access folder.

2. Pull down the Tools menu and click the 
Relationships command to open the 
Relationships window as shown in Figure. Pull 
down the relationships menu and click the Show 
Table dialog box.
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Hands-on Exercise 3: Step 1 – Open 
the Relationship Window
3. Click (select) the Location table (within the 

Show Table dialog box), then click the Add 
button to add this table to the relationships 
window.

4. Double click the Titles and Employee tables to 
add these tables to the Relationships window. 
Close the Show Table dialog box.

Step 2-7 is to be cont. next week
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Chapter 1 Summary

Six object types: 

Tables, Forms, Queries, Reports, Macros, & Modules

A table is composed of records

Records are composed of fields

Tables views: 

Design, Datasheet, PivotTable, or PivotChart

Exploring Access 2003 Revised - Grauer and Barber 64

Data validation is critical

A filters applies a criteria to display a 
subset of records

Relational databases contain multiple 
related tables

Allows for referential integrity and data 
validation

Chapter 1 Summary (Continued)
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End-of-chapter Exercises 

Multiple Choice
Practice With Access

Exercise 1 – The Oscars
Exercise 2 – Definitely Needlepoint
Exercise 3 – The United States
Exercise 4 – Large Databases
Exercise 5 – The Look Ahead Database
Exercise 6 – Peppy’s Restaurants
Exercise 7 – Peppy’s Relational Database
Exercise 8 – Metro Zoo
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End-of-chapter Exercises (Continued)

Practice with Access (continued)
Exercise 9 – Finding a Physician

Mini Cases
Online Study Guide
Garbage In, Garbage Out
Chapter Recap – Natalie’s Cuppa Joe
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Questions?

Exploring Access 2003 Revised - Grauer and Barber 68Committed to Shaping the Next Generation of IT Experts.

Chapter 2- Tables and 
Forms: Design, Properties, 

Views, and Wizards
Robert Grauer and Maryann Barber

Exploring Microsoft 
Access 2003

Revised Edition
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Objectives

Describe table design

Describe data types and properties; set a 
primary key

Use Table Wizard; Modify a table design

Discuss data validation importance
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Objectives (continued)

Use Form Wizard; modify a form design

Distinguish between bound, unbound, and 
calculated controls

Add combo box and command buttons

Use a form to add, edit, and delete records
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Case Study: Debbie’s Fine Fashions

The case requires students to:
Create a database; set field properties

Create a form to enter the data

Modify the form to include command 
buttons and clip art

Use the form to enter data
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Table Design Basics

Include necessary data

Store data in its smallest parts

Avoid calculated fields
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Creating a Table
Two ways to create a table:

Table Wizard is easiest
Design a table yourself

Every field has a field name
Every field has a data type
Primary key – Makes each record unique
Views: Datasheet or Design
Properties – characteristics of an object
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Data Types

Number field

Text field 

Memo field 

Date/Time field 

Currency field

Yes/No field

OLE field

AutoNumber

Hyperlink field
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New Table Screen

Click on New Button

Select view for 
new table
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Primary Key

Table Design View

Field Names

Data Type

Field Properties

Field Descriptions
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Properties

Field size

Format

Input Mask

Caption

Default Value

Validation Rule

Validation Text
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Properties (continued)

Required 
Allow Zero Length
Indexed 
Unicode Compression
IME Mode
IME Sentence Mode
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Table Wizard Screen

Click Create table 
using wizard

Select Fields

Select from 
Sample Tables

Click to add 
selected field
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Table Wizard Screen (continued)

Let Table Wizard 
set the primary 
key

Enter name for table
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Create an Input Mask

Click Build button

Select Social 
Security Number

Select Yes for 
Required property

Select Input Mask

Use Try It box
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Hands-on Exercise 1

Title of Exercise: Creating a Table

Objective: to create a new database; use 
Table Wizard to create a table; to add and 
delete fields of an existing table

Input file: None
Output file: My First Database
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Hands-on Exercise 2

Title of Exercise: Creating a Form

Objective: to use the Form Wizard; to move 
and size controls; to use the completed form 
to enter data in the associated table

Input file: My First Database (modified after 
exercise 1)

Output file: My First Database (modified)
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Hands-on Exercise 1: Step 1 –
Creating a Table
1. Click the Start button, click the All Programs 

button, click Microsoft Office, then click 
Microsoft Office Access 2003 to start the 
program

2. Click Create a new file at the bottom of the 
Getting Started task pane, then click Blank 
database in the New File task pane. (If the 
task pane is not open, click the New button
on the toolbar)
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Hands-on Exercise 1: Step 1 –
Creating a Table
3. You should see the File New Database 

dialog box as shown in Figure
4. Click the drop-down arrow on the Save In 

list box and select the appropriate drive. 
Double click the Exploring Access folder.

5. Click the File Name text box and drag to 
select db1. Type My First Database as the 
name of the database you will create. Click 
the Create button
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Hands-on Exercise 1: Step 2 – The 
Table Wizard
1. The Database windows for My First Database 

should appear on your monitor. The Table button 
is selected by default

2. Double click the icon to Create table by using 
wizard to start the Table Wizard as shown in 
Figure. Click the Business option button.

3. Click the down arrow on the Sample Tables list 
box to scroll through the available table until you 
can select button so t (click) the Student table (The 
student table is found near the bottom of the list)
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Hands-on Exercise 1: Step 2 –
The Table Wizard

3. The StudentID field is already selected in the 
Sample Fields list box. Click the > button to enter 
this field into the list of fields for the new table.

4. Enter the additional fields for the new table by 
selecting the field and clicking the > button (or 
double clicking the field). The fields to enter are 
FirstName, LastName, Address, City and 
StateOrProvince.

5. Click the Rename Field button after adding the 
StateOrProvince field to display the Rename Field 
dialog box. Enter State to shorten the name of this 
field. Click OK to accept the new name and close 
the dialog box.
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Hands-on Exercise 1: Step 3 – The 
Table Wizard Continued
1. Add PostalCode and PhoneNumber (you may 

need to click the down arrow to scroll). Click Next
2. The next screen in the Table Wizard asks you to 

name the table and determine the primary key.
Accept the Wizard’s suggestion of Students as the 
name of the table
Make sure that the option button Yes, set a primary 
key for me is selected as shown in Figure
Click Next to accept both of these options
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Hands-on Exercise 1: Step 3 – The 
Table Wizard Continued

3. The Final screen in the Table Wizard asks you what 
you want to do next.

Click the option button to Modify the table design
Click the Finish command button

4. The Students table should be appear in Design 
view. Pull down the File menu and click Save (or 
click the Save button on the Table Design toolbar) to 
save the table within database

5. The Table Wizard provided an easy way to create 
the table initially. You can now modify the table in 
Design as described in the next several steps.
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Hands-on Exercise 1: Step 4 – Add 
the Additional Fields
1. Click the Maximize button to give yourself more 

room to work. Click the cell immediately below the 
last field in the table (PhoneNumber). Type 
BirthDate as shown in Figure.

2. Press Tab key to move to the Data Type column. 
Click the down arrow on the drop-down list box. 
Click Date/Time. (You can also type the first letter 
of the field type such as D for Date/Time, T for 
Text, or N for number).
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Hands-on Exercise 1: Step 4 – Add 
the Additional Fields

3. Add the remaining fields to the Student table
Add Gender as a Text field
Add Credits as a Number field
Add QualityPoints as a Number field. (There is no 
space in the field name)

4. The additional fields are unique to our 
application and were not available in the wizard

5. Click the Save button to save the table.
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Hands-on Exercise 1: Step 5 –
Change the Primary Key
1. Point to first field in the table and click the right 

mouse button to display the shortcut menu in 
Figure. Click Insert Rows

2. Click the Field Name column in the newly 
inserted row. Type SSN (for Social Security 
Number) as the name of the new field. Press 
Enter. The data type will be set to Text by 
default

3. Click the Required box in the Properties area. 
Click the drop-down arrow and click Yes



Exploring Microsoft Word 7.0

Carlotta Eaton

Exploring Access 2003 Revised - Grauer and Barber 93

Hands-on Exercise 1: Step 5 –
Change the Primary Key
4. Click in the Field Name column for SSN, then 

click the Primary Key button on the Table 
Design toolbar to change the primary key for 
Social Security Number. The primary key 
symbol has moved to SSN

5. Point to the StudentID field in the second row. 
Click the right mouse button to display the 
shortcut menu. Click Delete Rows to remove 
this field from the table definition

6. Save the table.
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Hands-on Exercise 1: Step 6 –
Create an Input Mask

1. Click the field selector column for SSN. Click the 
Input Mask box in the Properties area. (The box ix 
currently empty)

2. Click the Build button to display the input Mask 
Wizard. Click Yes if asked to save the table. Click 
Social Security Number in the Input Mask Wizard 
dialog box as shown in Figure.

3. Click the Try It text box and enter a Social Security 
Number to see how the mask works. If necessary 
press the left arrow key until you are at the beginning 
of the text box, then enter a Social Security Number 
(digits only)
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Hands-on Exercise 1: Step 6 –
Create an Input Mask

4. Click the Finish command button to accept the 
input mask. Click in the text box for the Field 
Size property and change the field size to 9

5. Click the field selector column for BirthDate, then 
follow the steps detailed above to add an input 
mask. (Choose the Short Date format). Click Yes
if asked whether to save the table

6. Set an appropriate input mask for the telephone 
number as well. Change the field size to 10

7. Save the Table
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Hands-on Exercise 1: Step 7 –
Change the Field Properties
1. Click the field selector column for the FirstName

field. Click in the text box for the Field Size 
Property and change the field size to 15. Change 
the Required property to Yes.

2. Select the LastName field. Set the Field Size 
property to 20 and the Required property to Yes.

3. Select the State field. Set the Field Size property
to 2 Click the Format box in the Properties Area. 
Type a > sign to display the data in uppercase as 
shown in Figure. Click in the InputMask property
and type LL to require letters as opposed to digits
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Hands-on Exercise 1: Step 7 –
Change the Field Properties
4. Select the Credits field. Click the Field Size box

in the Properties area, click the down arrow to 
display the available field sizes, then click 
Integer. Click in the Default property box, and 
delete the default value of zero.

5. Set the Field Size and Default properties for the 
QualityPoints field to match those of the Credit 
field

6. Save the table.
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Hands-on Exercise 1: Step 8 – Add a 
Validation Rule

1. Data Validation is implemented in several ways. 
You can set the Required property to Yes to 
ensure that a value is entered and/or you can 
create an input mask to accept only certain 
characters. You can also set the Validation Rule 
property.

2. Select the Gender field as shown in Figure. Click 
the Field Size box and change the field size to 1

3. Click the Format box in the Properties area. 
Type a > sign to display the data in uppercase 
letters
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Hands-on Exercise 1: Step 8 –
Add a Validation Rule

4. Click the Validation Rule box. Type =“M” or “F” to 
accept only these values on data entry. Click the 
Validation text box, and type. You must specify 
M or F (This message explains the error to the 
user)

5. Check that the required property is set to “No” so 
that gender is not required. If the user enters a 
value, however, it must be “M” or “F”

6. Click the Save button to save the table.
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Hands-on Exercise 1: Step 9 – Print 
the Student Table
1. Pull down the View menu and click Datasheet 

View to change to the Datasheet View as shown in 
Figure. Enter Data for yourself, but use a 
hypothetical Social Security Number such as 123-
45-6789. (Note the input mask that appears)

2. Pull down the File menu and click the Page Setup 
command to display the Page Setup dialog box. 
Click the Page tab and change to Landscape 
printing.

3. Click the Margin tab. Change the left and right 
margins to .5 inch. Click OK
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Hands-on Exercise 1: Step 9 –
Print the Student Table
4. Click the Print Preview button to review the 

table to check that it fits on one page. (If not, 
return to the Datasheet view and reduce the 
column widths as necessary) 

5. Pull down the File menu, click the Print 
command, and click OK to print the table. Close 
the Print Preview window. Close the Students 
table. Click Yes if prompted to save the 
changes to the table

6. Pull down the File menu, and click the Exit 
command if you don’t want to continue
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Forms

Form view
Displays completed form
Used to enter or modify data in underlying 
table

Design view
Used to create or modify the form
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What They Look Like
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Creating a Form

Controls

Bound control — has data source

Unbound control — no data source

Calculated control — expression as data 
source
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Form Design View

Unbound control

Sizing handles

Bound Control
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Form View

Unbound control

Bound Control
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Form Wizard

Click New button

Click Form Wizard

Select Table

Exploring Access 2003 Revised - Grauer and Barber 108

Form Wizard (continued)

Click >> to select all 
fields for form

Click Next >
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Sophisticated Forms

Additional controls to use on forms
Drop-down list box (using Lookup Wizard)
Check box
Option group

Command buttons
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Lookup Wizard

Select Lookup Wizard
Select to type the values

Enter the Majors
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Add New Controls

Major is then added as a combo box

Click and drag field from field 
list to form design grid
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Option Group Wizard

Drag the Option 
Group button onto the 
form to enable the
Option Group Wizard

Type the label names

Accept the default values

Store the values in a field
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Command Button Wizard

Drag the Command Button 
tool onto the form to enable 
the Command Button 
Wizard

Select Category 
and Action

Select Text Display

Add a name to the button

Creates a command button
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Hands-on Exercise 3

Title of Exercise: A More Sophisticated Form
Objective: to use the Form Wizard; to move 
and size controls; to use the completed form 
to enter data in the associated table

Input file: My First Database (modified after 
exercise 2)

Output file: My First Database (modified)
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Chapter 2 Summary

Information depends on underlying data

Divide data into smallest units

Database design is critical

Table Wizard: creates tables easily
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Chapter 2 Summary (continued)

A form provides easy way to enter and 
display data

A form consists of objects called controls

A property is a characteristic or attribute of an 
object
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End-of-chapter Exercises 

Multiple Choice
Practice With Access

Exercise 1 – A Modified Student Form
Exercise 2 – The United States Database
Exercise 3 – The Super Bowl
Exercise 4 – The Fishing Pole
Exercise 5 – A Form for the Fishing Pole
Exercise 6 – The Shopping Mall
Exercise 7 – A Form for the Shopping Mall
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End-of-chapter Exercises (continued) 

Practice With Access (continued)
Exercise 8 – Best Realty
Exercise 9 – A Form for Best Realty
Exercise 10 – Events Extraordinaire
Exercise 11 – A Form for Events Extraordinaire 
(with Tab Controls)
Exercise 12 – Paw Prints
Exercise 13 – About Our Students
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End-of-chapter Exercises (continued) 

Mini Cases
Employee Compensation
The Stockbroker
Chapter Recap – Kahakai Villas
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Questions?


